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End User License Agreement (EULA)

The Beast (henceforth ‘the Product’) is licensed to you as the end 

user.  Please read this Agreement carefully.

You cannot transfer ownership of these Sounds and Software they 

contain. You cannot re-sell or copy the Product.

LICENSE AND PROTECTION 

1. License Grant

UVI grants to you, subject to the following terms and conditions, a 

non-exclusive, non-transferable right to use each authorized copy of 

the Product. 

The product is the property of UVI and is licensed to you only for 

use as part of a musical performance, live or recorded. This license 

expressly forbids resale or other distribution of the sounds and 

software included in the Product or their derivatives, either as they 

exist on disc, reformatted for use in another digital sampler, or mixed, 

combined, filtered, resynthesized or otherwise edited, for use as 

sounds, multi-sounds, samples, multi-samples, wavetables, programs 

or patches in a sampler, microchip or any hardware or software 

sample playback device. 

You cannot sell the Product content or give it away for use by others 

in their sampling or sample playback devices. In the event UVI 

terminates this agreement due to your breach, you agree to return 

the original and all other copies of the software and documentation 

to UVI.

UVI reserves all rights not expressly granted to herein. 

2. Protection of Software

You agree to take all reasonable steps to protect the product and any 

accompanying documentation from unauthorized copying or use. You 

agree not to modify the product to circumvent any method or means 

adopted or implemented by UVI to protect against or discourage the 

unlicensed use of copying of the Product. 

3. Ownership

As between you and UVI, ownership of, and title to, the enclosed 

digitally recorded sounds (including any copies) are held by UVI. 

Copies are provided to you only to enable you to exercise your rights 

under the license. 

4. Term

This agreement is effective from the date you open this package, 

and will remain in full force until termination. This agreement 

will terminate if you break any of the terms or conditions of this 

agreement. Upon termination you agree to destroy and return to UVI 

all copies of this product and accompanying documentation. 

5. Restrictions

Except as expressly authorized in this agreement, you may not rent, 

sell, lease, sub-license, distribute, transfer, copy, reproduce, display, 

modify or time share the enclosed product or documentation. 

 

©2014 UVI. All rights reserved.
All trademarks are the property of their respective owners.

Do not use this product until the following license agreement is understood and accepted.
By using this product, or allowing anyone else to do so, you are accepting this agreement.
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The Beast - Rewind to 1975 ...

A machine of luxury is birthed for the musical elite. 

Using electronics developed for NASA, this revolutionary 

instrument was unprecedented for its time. Starting off its 

life as a gorgeous FM synth, it evolved into a comprehensive 

workstation through subsequent expansions. Its emergence 

into the professional studio inspired many of the leading 

avant-garde artists and sonic visionaries to embrace its 

potential, including Frank Zappa, Chick Corea, Michael 

Jackson, Sting, Kraftwerk, Stevie Wonder, and Depeche  

Mode, among others.

... Fast Forward to Today

Once again inspired by the sounds of yesteryear, we at UVI 

have set out to construct our own ‘beast’. The result is a 

comprehensive software suite comprised of 3 complementary 

digital instruments - each fully equipped with a vast array 

of both cutting edge original sounds and classic presets. 

We’ve employed our trusted combination of advanced 

programming and meticulous sampling, using the best analog 

and digital gear, to bring the beloved vintage character of 

this workstation to a new generation of musicians and sound 

explorers. The result is an entirely new, comprehensive and 

intuitive luxury instrument which we are proud to present 

to you - The Beast.

Also included is the latest UVI technology - Sparkverb™, 

a highly advanced synthetic reverb that focuses on sound 

quality and musicality. From stratospheric choruses, to lush 

ambiances and to resonant unisons, Sparkverb gives you a 

huge palette and direct control over the patches. Add lush 

atmosphere to any of your configurations instantly!

Recapture the past, and let The Beast inspire the sounds of 

your future!

Introduction
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System Requirements

Compatibility
Audio Units, VST, MAS, AAX, RTAS or standalone

UVI Workstation 2.5.2 or higher

Minimum System Requirements
  Intel CPU 

  4 GB of RAM (8 GB+ recommended)

  2 GB of disk space

  Mac OS X 10.7 or higher

  iLok account (free, dongle not required)

Compatibility 
VST, AAX, RTAS or standalone

UVI Workstation 2.5.2 or higher

Minimum System Requirements
  Core Duo or faster

  4 GB of RAM (8 GB+ recommended)

  2 GB of disk space

  Windows 7 or higher

  iLok account (free, dongle not required)

Authorize the Way You Want
Your license allows 3 concurrent authorizations on any combination of computers and iLok dongles.  

License management is a simple drag-and-drop process done through iLok License Manager.

Visit ilok.com/  to download iLok License Manager and create your free account.
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  You must have an account on uvi.net/  and ilok.com/  prior to registration

  If you purchased a physical version of this product, your serial number is located on the inside of the box

  If you purchased an electronic version of this product, your serial number will be included in a confirmation email

  You can see a list of the products you’ve registered and their serial numbers anytime at uvi.net/my-products 

1. Login to your account on uvi.net/

2. Navigate to the ‘Product Registration’ page

3. Enter your details and click ‘Register’

 Upon completion a new license will be
 deposited in your iLok account

1 2 3 4Register Your Serial NumberStep 1
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1. Launch iLok License Manager

2. Login to your account

3. Click the ‘Available’ tab

4. Drag the license to your computer
 or an iLok dongle

5. Click ‘Ok’ to confirm the activation

 The process is complete, your  
 device is now authorized

  iLok License Manager is required for activation, download the newest version at ilok.com/ilm.html  

  Your license allows up to 3 concurrent activations on any combination of iLok dongles and computers

  Activations can be moved between devices at anytime

» To see how many authorizations you have left simply select the license and click ‘Show Details’

» To deactivate your license, right-click it and select ‘Deactivate’ — doing so will return your license to the ‘Available’ tab

1 2 3 4Activate Your LicenseStep 2
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2. Open UVI Workstation

3. Click the Settings page

4. Click the ‘Sound Banks’ tab

5. Click the ‘...’ button and select
 the folder where you’ve placed 
 your instruments

6. Restart UVI Workstation and 
  open the Browser

 Your instruments will be available  
 under the ‘Soundbanks’ tab

  UVI Instruments can be stored anywhere on your system

  Storing your instruments on a fast drive will improve performance

  Your instruments can be downloaded at any time from uvi.net/my-products 

1. Create a folder on your computer and place your UVI Instruments in it
 Once this is done we need to tell UVI Workstation where to find your instruments.

 We do this by creating a watch folder, follow the steps below to create your own:

Install Your InstrumentStep 3 1 2 3 4
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1. Open UVI Workstation

2. Click the Browser icon

3. Open the Sound Banks tab

4. Select a product, in this example 
 we’ll choose Vector Pro, then  
 select an instrument and patch 

 Double-click the patch to load it

5. The UI appears and you’re ready to jam!

1 2 3 4

  UVI Workstation is required to run UVI Instruments

  The newest version of UVI Workstation can be downloaded free at uvi.net/downloads 

  UVI Workstation can be run as a standalone program or as a virtual instrument from within your DAW of choice

Load Your InstrumentStep 4
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Beast FMII - Interface

1  Amplitude
» ADSR

Typical envelope controls for the amp

» Vel Sens

Velocity sensitivity

2  Filter
» ADSR

Typical envelope controls for the filter

» Vel Sens

Velocity sensitivity

» HP / BP / LP

High, Band, and Low Pass filter modes

» Cutoff

Filter cutoff frequency

» Res

Filter resonance amount

» Env

Depth of the filter envelope

3  Stereo
» Mode - Off

» Mode - Alt

Stereo position alternates L/R every 

note, width controlled by [SPREAD]

» Mode - Uni

Layers multiple samples and augments 

them for increased stereo presence

» Color

Utilizes neighboring samples from the 

library to a unique effect

» Spread

Sets the stereo width (ALT mode)

» Tune

Detunes the unison layers (UNI mode)

4  Effects
» Phaser

On/off and effect mix amount

» Delay

On/off and effect mix amount

» Reverb

On/off and effect mix amount

» Crusher

 On/off and effect minx amount

5  Drive
» Power/Amount

 On/off and overdrive amount

6  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth

7  FMIZER
 Note: FMIZER is playable via the   

 modwheel

» ‘+’ or ‘-’

Adjust FM modulation

» Level

FM level amount

» Pitch

Transpose FMIZER by semi-tone

» Velocity

FMIZER velocity sensitivity

1Amplitude

7FMIZER

6Modwheel

2 Filter

3 Stereo

5 Drive

4 Effects



11

Beast FMII - Preset List

Bass

Bass Funky M

FMized Bass

MG AnalogBass

Orchestral Bass

Orchestral FMized

Orig Bass 1

Orig Bass 2

Orig Bass 3

Orig Bass 4

Phat FM Bass

Bells

Chimes

Church Bells

FM Zic Box

Harpi Bell

Music Box

Orig Bells 1

Orig Bells 2

Tangerine Bell 

Tubular Chimes

Vibes

Insane FM

Das Dubstep

Distoland

FM Attitude

Insane Place

Organistic

Rock FM

The Beast who Fly

Violin under Pressure

Voices Insane

Wheel Sweep Brass

Keyboards

Clavinet

Elec Dulcimer 1

Elec Dulcimer 2

Electric Piano 1

Electric Piano 2

Harpsichord

Heavy Keyboard

Low FM Piano

Mallet Piano

Piano FMized

Misc.

ChorGelis

FM Dream Kalim

FM Noisy Bell

Fuzz Guitar

Fuzzemized

Harmonica

Poly Sync

Pure FM Thin Pad

Strummed

Ultra Thin Perc

Orchestral

Brass

Hybrid Violin

Krum Horn

Krum Multi FM

Mellow Ensemble

Ochestral Hit

Octaved

Orchestral Strings

Porta Strings

X Fantasio

Organs

Brocken Organ

FH Organ FMized

FH Organ

Full Digital Organ

Harpsi Hamm

Large FM Organ 1

Large FM Organ 2

Mini Organ

Pipe Organ

Rock Wah

Synth

BrasSource

Dirty Fifth

Iconic Gong

Marion 1

Marion 2 FMized

Poly FM

Saw Lead

Slow Drone

Smooth Keys

Strange Voices

Voices

Waveforms

FMized Only

Inverted Saw

Saw

Sine 1

Sine 2

Square

Triangle
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Beast Terminal - Interface

1  Amplitude
» Vel > Atk

Remaps Attack » Note Velocity

» Velocity Sensitivity

Adjust the velocity sensistivity

» ADSR

Typical envelope controls for the amp

2  Filter
» Filter Type

Multimode filter can be set to low-pass 

(LP), band-pass (BP), or high-pass [HP]

» ENV

Depth of the filters EG

» CUT

Filter cutoff frequency

» RES

Filter resonance amount

» VEL

Adjust the filter velocity sensitivity

» ADSR

Typical envelope controls for the filter

3  Pitch Envelope
» Depth

Sets the depth of portamento

» Time

Sets the glide time for both modes

4  Drive
» On/Off Switch

» Amount

Sets the drive amount

5  Stereo
» Mode - Off  (mono)

» Mode - Alt

Stereo position alternates L/R every 

note, width controlled by [SPREAD]

» Mode - Uni

Layers multiple samples and augments 

them for increased stereo presence

» Color

Utilizes neighboring samples from the 

library to a unique effect

» Spread

Sets the stereo width (ALT mode)

» Tune

Detunes the unison layers (UNI mode)

6  Effects
» Phaser

Power and effect mix amount

» Delay

Power and effect mix amount

» Reverb

Power and effect mix amount

7  Bit Crusher
» Bit Crusher On/Off

 Enable/Disable the Bit Crusher effect

» Bit

 Set the bit reduction

» Frequency

 Set the Bit Crusher sample rate

» Drive

 Adjust the overdrive amount of the 

 Bit Crusher effect

8  Modwheel
» Power/Amount

Easily route your controllers Modwheel 

to control common parameters such as 

Vibrato, Tremolo and Filter Depth

1Amplitude

8Modwheel

4Drive

5Stereo

3Pitch Envelope

2Filter

6 Effects

7 Bit Crusher
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Beast Terminal - Preset List

Bass

Agressiv Mini Mg

Bass ConTremolo

Bass Synth 1

Bass Synth 2

Bass Synth 3

Crunch Bass

Dark Double Bass

Electric Bass 1

Electric Bass 2

Fretless Blue

Hard Bass

Noise Drone Bass

Phat SUB

Piano Bass Bells

That Slap

Ultra Air Bass

Bell-Mallets

African Mallet

Celeste

Glockenspiel

Kalimba

Marimba 1

Marimba 2

Marimbass

Old Bells

PitchAgogo

Prepared Dulcimer

Prepared Gamelan

Prepared Mallet

Prepared Xylo

Steel Drum

Synth Bell

TremoBell

Vibraphone

Woodblock

Woody Stacc

Xylophone

Brass

Big Brasses

Big Ensemble

Brass Attack 1

Brass Attack 2

Brassy Big Pad

French Horn

Horns and Strings

Tenor Sax

Trumpet Stacc 1

Trumpet Stacc 2

Tuba

Wahx Avery

Drums

Bass Drums 1

Bass Drums 2

Cymbals 1

Cymbals 2

Cymbals 3

Snare Drums 1

Snare Drums 2

Snare Drums 3

Toms 1

Toms 2

Toms 3

FX

Dolphin Stress

Fallling P

FX Menu 1

FX Menu 2

FX Menu 3

Hitchcokitude

Horror Scene

Human Menu

Marsian Gamelan

Prepared Cluster

Prepared Pianos

RiskPlosion

Scaring Steel

Space Chimes

Trashing

Tunnel Scary

UnHarmonic Mallet

Xtreme Prepared

Guitars

Acoustic Guitar

Banjo

Classic 335

El Guitar Mute

Electric Guitar 1

Electric Guitar 2

Lute

Stratlute

Twelve Strings 1

Twelve Strings 2

Hits-Chords

FX Synth Hit

Hit Chkoc

Impact Tunning

Jazz Ending

Magic Hit 1

Magic Hit 2

Moscito Hit

NoisHit

Orch Dark Hit

Orchestal Mood

Out Brass Phase

Phrase Ending 1

Phrase Ending 2

Pop Hit

Pure Orch Hit 1

Pure Orch Hit 2

Pure Orch Hit 3

Pure Orch Hit 4

Pure Orch Hit 5

Pure Orch Hit 6

Pure Orch Hit 7

Pure Orch Hit 8

Pure Orch Hit 9

Requiem Hit 1

Requiem Hit 2

Requiem Hit 3

Short Hit

StaBrass

Suspense Hit 1

Suspense Hit 2

Suspense Hit 3

Suspense Hit 4

Tension Loop

TimpanHit

xFX Hit 1

xFX Hit 2

xFX Hit 3

xFX Hit 4

xFX Hit 5

Ze Art of Hit

Keyboards

Accordion

Church Organ

Claustro B3

Clavinet

Crunchy Ham

Dark Road

German Big Toy

Grand Piano

HarPiano

Harpsichord

Majestic Prepared

MelHarmonica

My Dyno Piano 1

My Dyno Piano 2

New Piano

On the Road

Student Piano

Tack Piano

Zither Piano

Percussions

Berimbau

Bongo

Cabasa

Conga

Ethnic Mood

Flexatone

Gong

Hybrid Perc

Perc Menu 1

Perc Menu 2

Perc Menu 3

Perc Menu 4

Perc Menu 5

Perc Orch Hit

Piano Hit

Surdo

Timpani

Tribal Class

Udu
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Global Controls

Modulation Controls
Pitch Bend » 2 Octave Range

ModWheel » BitCrusher

1  Page Switch
» Page 1

01. Bass Drum - C1

02. Snare Drum - D1

03. Cymbal - F#1

04. Cymbal - D#2

» Page 2

05. Tom - F1

06. Tom - G1

07. Percussion 1 - C#1

08. Percussion 2 - D#1

» Page 3

09. FM BD/SD - B0

10. FM BD/SD  - E1

11. FM Cymbals/Toms/Percs - A#1

12. FM Cymbals/Toms/Percs - A1

2  Preset Menu
Select from dozens of preset kits

3  Globals
» Groove / Swing Amount

» Clear (all seq tracks)

» Play/Stop Sequencer

4  Step Indicator
LED lights indicate current seq step

Track Controls

5  Track Params
» Mute (on/off)

» Sample Menu

Change the track/sample via forward/

backward buttons or through the pull-

down menu

» Vol

Adjust the track volume

» Pan

Adjust the tracks pan position

» Tune

Adjust the track pitch

» HF (Low-Pass Filter)

Adjust the filter cutoff frequency

» LF (High-Pass Filter)

Adjust the filter cutoff frequency

» Drive

Adjust the amount of overdrive

» Decay

Adjust the sample decay time

» Aux 1

Adjust the delay send amount

» Aux 1

Adjust the reverb send amount

6  Track Sequencer
full velocity (light on)

half velocity (half light)

disabled (light off)

Beast Box - Interface

1Page Switch

2Preset Menu

5Track Params

6Track Sequencer

4Step Indicator

3 Globals
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Beast Box - Preset List

1: BD

80s 1

80s 2

100 per cent

Agression S

Balboa 1 S

Balboa 2 S

Cameo Room S

Cheap Acoustic

Chopped 1

Chopped 2

Chopped 3

Da Beast 1

Da Beast 2

Da Beast 3

Da Room 1

Da Room 2

Detune Acc

Dirty 1

Dirty 2

Dynamic Room

Explosion 1 S

Explosion 2 S

Fat Roomy S

Flat Box

Gated S

Heavy 1

Heavy 2

Height 08

Hi Loose S

Hi Tight S

In your Face

Large Booth S

Lo Fi

Loud and Dirty

Loud

Low 1

Low 2

Low 3

Low Mid

Machine Long

Machine Short

Massive Booth

Metal Strange

Natural 1

Natural 2

Nine 09

Old School

On the Floor

Paper S

Phasing 1

Phasing 2

Pure 80s

Resonance

Room Cut

SD Like S

Serious One

Sharp 1

Sharp 2

Simmons

Skinny

Slap Room 1 S

Slap Room 2

Slap Room 3 S

Small Room

Soft

Standard

Static

Straight

Sync BD

Tight HHO

Tight One

Timba Trash

Timbre S

Tonalix

Transparent

Tribelec

Typical Live

Usefull

Very Tight 1

Very Tight 2

Very Tight 3

Whats your Name

2: SD

CLP 808 Basic

CLP 808 little

CLP Bionic

CLP Electric S

CLP Ensemble 1 S

CLP Ensemble 2 S

CLP Kevin Brush

CLP Machine 1

CLP Machine 2

CLP Machine 3

CLP Machine 4

CLP Real 1

CLP Real 2

CLP Real 3

CLP Slap

CLP Synclap 1

CLP Synclap 2

CLP Synclap 3

CLP Ultra Sharp

RM Beast 1

RM Beast 2

RM Clap

RM Cutted

RM Real Hard

RM Real One

RM Real Soft

RM Ring

RM Stereo 1

RM Stereo 2

RM Stereo 3

SD Almost BD

SD Brushed

SD Came How

SD Classic 1

SD Classic 2

SD Fla Bidi

SD Full S

SD Funky S

SD Gated Long

SD Glass Break

SD Heavy S

SD Hi 1 S 

SD Hi 2

SD Hi 3

SD Hi 4

SD Hi 5 S

SD In your Face

SD Jazzy 1

SD Jazzy 2

SD Jazzy 3

SD Key Vine

SD Little SD

SD Low 80s

SD Medium Gate 1

SD Medium Gate 2

SD Medium Gate 3

SD Metallic S

SD OB DX

SD Obese 1 S

SD Obese 2 S

SD Overhead S

SD Phasing S

SD Punchy

SD Pure Acc 1

SD Pure Acc 2

SD Pure Acc 3

SD Pure Acc 4 S

SD Pure Acc 5

SD Pure Acc 6 S

SD Raggae

SD Reflection S

SD Resolarge 1 S

SD Resolarge 2 S

SD Resolarge 3 S

SD Resolarge 4 S

SD RockRoom 1 S

SD RockRoom 2 S

SD Rol Eight

SD Roomy1

SD Roomy2

SD Shark

SD Sharp 1

SD Sharp 2 S

SD Sharp 3

SD Sharp 4 S

SD Short Mute

SD Shotgun 1 S

SD Shotgun 2 S

SD Slappy S

SD Small 1

SD Small 2

SD Small 3

SD Small 4

SD Small 5

SD Small 6

SD SnAir 1 S

SD SnAir 2 S

SD SnAir 3 S

SD SnAir 4 S

SD Speed Gating

SD SRoom 1 S

SD SRoom 2 S

SD Stackattack 1

SD Stackattack 2

SD Sustain Dark

SD Sustained

SD SyncD 1 S

SD SyncD 2

SD SyncD 3

SD SyncD 4 S

SD SyncD 5 S

SD Timbales 1

SD Timbales 2

SD Tiny 1 S

SD Tiny 2 S

SD Tiny 3 S

SD Tiny 4 S

SD Tiny 5

SD Tiny Brush 1

SD Tiny Brush 2

SD Ultra Metal S

SD Ultra Room S

SD Vinyl

SNP 1 Low

SNP 2 Close

SNP Heavy

SNP Snaplavier

3-4: Cymbals

CRASH 808

CRASH Basic

CRASH Chinese1

CRASH Chinese2S

CRASH Dark Kik

CRASH Electric

Crash Foot HH

CRASH Large 1 S

CRASH Large 2 S

CRASH Large 3 S

CRASH Large 4 S

CRASH Lrg Sml S

CRASH Lttl Spalsh

CRASH MCrash 1

CRASH MCrash 2

CRASH MCrash 3

CRASH Med 1 S

CRASH Med 2

CRASH Med 3 S

CRASH Med 4 S

CRASH Metal H

CRASH Muted 1 S

CRASH Muted 2 S

CRASH Muted 3 S

CRASH Muted 4 S

CRASH Muted 5 S

CRASH Piccolo 1

CRASH Piccolo 2

CRASH Picclo Mtd

CRASH Riding S

CRASH Sft Splash

CRASH Splash S

CRASH Splashy 1

CRASH Splashy 2

CRASH Big Ride

HH 808

HH Big Closed

HH Closed A 1

HH Closed A 2

HH Closed B 1

HH Closed B 2

HH Closed C 1

HH Closed C 2 S

HH Closed D 1

HH Closed D 2 S

HH Closed E 1

HH Closed E 2

HH Dark Metal

HH Foot 1

HH Foot 2

HH Foot 3

HH Foot 4

HH Foot 5

HH Foot 6

HH Hard

HH High S

HH Large S

HH Light

HH Low

HH Majestic 

HH Majestic 1

HH Majestic 2

HH Majestic 4

HH Muted Cymb S

HH Nineteen 1 S

HH Nineteen 2 S

HH Pure 1 S

HH Pure 2 S

HH Pure 3 S

HH Pure 4 S

HH Pure 5 S

HH Sculted

HH Simple S

HH Smooth S
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Beast Box - Preset List (continued)

HH Steady 1

HH Steady 2

HH Steady 3

HH Steady 4

HH Straight

HH Twenty S

HHO 808

HHO Classic 1

HHO Classic 2

HHO Classic

HHO Closing 1

HHO Closing 2 S

HHO Closing 3 S

HHO Foot 1

HHO Foot 2

HHO Light

HHO Machine

HHO Old Long

HHO OP Crash S

HHO Open 1 S

HHO Open 2 S

HHO Open 3 S

HHO Open 808

HHO Steady Long

HHO Steady Med

HHO Steady Short

HHO Vinyl 1

HHO Vinyl 2

RIDE Bell 1

RIDE Bell 2

RIDE Bell 3

RIDE Bell 4 S

RIDE Bell 5 S

RIDE Bell 6

RIDE Crashy 1 S

RIDE Crashy 2 S

RIDE Crashy 3 S

RIDE Crashy 4 S

RIDE In your F

RIDE Mtd Crash 1

RIDE Mtd Crash 2

RIDE Pure Cool

RIDE Pure Hard

RIDE Reading S

RIDE Serious1 ST

RIDE Serious2 ST

RIDE Smart 1 S

RIDE Smart 2 S

RIDE Smart 3 S

RIDE Standard S

RIDE XStatic Hard

RIDE XStatic Soft

5-6: Tom

AlexT Hi

AlexT Low

Aligato Hi

Aligato Low

Angelix Hi S

Angelix Low S

Brazil Hi

Brazil Low

Brushes 1 S

Brushes 2 S

Cameo Hi

Cameo Low

Cutted Hi S

Cutted Low S

Dirty

Doors Hi

Doors Low

Electric 1

Electric 2

Electric 3

Explosive

Far Agress

Far Verb Hi

Far Verb Low

Godz Hi

Godz Low

Hangar Hi

Hangar Low

Hi Brush Hi S

Hi Brush Low S

Hook Sharp Hi

Hook Sharp Low

Huge Fat S

IToof Hi

IToof Low

JouzT Hi S

JouzT Low S

JouzT Med S

Keeta HI

Keeta Low

Kevin Hi

Kevin Low

Komissar Hi

Komissar Low

Larger S

LwBrushes cool S

LwBrushes hard S

LOWLow Cool

LOWLow Hard 

Magic T

Med Brushes 1 S

Medi Brushes 2 S

MGM Hi S

MGM Low S

MGM Medium S

Michael Hi S

Michael Low S

MilesD Hi S

MilesD Low S

Nitro Hi

Nitro Low

Nitro Med

Party Tom Hi

Party Tom Low

PatM Hi

PatM Low

PatM Med

Pointless Hi

Pointless Low

Pop Pow HI

Pop Pow Low

Power Hi S

Power Low S

Quick Hi S

Quick Med S

Romano Hi

Romano Low

Roto Hi

Roto Low

Tears4F Fla

Tears4F Hi

Tears4F Low

Tears4F Medium

TimbaL

Tiny Tom Hi

Tiny Tom Low

Tower Hi

Tower Low

Traveler Hi 1

Traveler Low 1

Tribalistic

Vertical Hi

Vertical Low

Water T

Xtreme Hi S

Xtreme Low S

Xtreme Med S

Yell Hi

Yell Low

Zoo One Hi

Zoo One Low

Zoo One Med

Zorma Cool

Zorma Hard

7: Percussions

Agogo 1 H

Agogo 1 L

Agogo 2 H

Agogo 2 L

BellTree 1

BellTree 2

BellTree 3 S

Big Tambourine

Bongo Shak S

Bongo Tribal

BongoB Long 1

BongoB Long 2

BongoB Long 3

BongoB Mute 1

BongoB Mute 2

BongoB Mute 3

BongoB Short 1

BongoB Short 2

Brush Ambiance

Cabasa 1

Cabasa 2

Cabasa 3

Castanets 1

Castanets 2

Castanets 3

Claperc

Clave 1

Clave 2

Clave 3

Clave 4

Clave Little

Clave Syn

Claves 1

Claves 2

Claves 3

Cong Low

Cong Mute

Cow Broken

Cow Clean

Cow Syn

Cowbell 1

Cowbell 2

Cowbell 3

Cowbell 4

Cowbell 5

Cowbell 6

Cowbell 7

Cymbourin 1

Cymbourin 2

Dark Gong

Djembe 1

Djembe 2

Djembe 3

Djembe 4

Double Tri

Egg 1

Egg 2

Egg 3

EggTriangle S

EL Bongo

Gongtronic

Guiro Biz 1

Guiro Biz 2

Guiro Biz 3

Guiro Biz 4

Gun Far

Hall Door 1

Hall Door 2

Hall Door 3

Hall Door 4

Hallmost Tom

Harmo Perc

Large Metal

Long Bell S

Low Conga

Maracas

Medium Stick

Metallic 1

Metallic 2

Metallic 3

Mini Cymb Long S

Mini Cymb Short

Muted Triangle

Pure Bell 1

Pure Bell 2

Shaker Clave

Sml Shekere 1

Sml Shekere 2

Sml Shekere 3

Sml Shekere 4

Snappy

Space Bell

Space Clave S

SynClave

Tambourell S

Timba Down

Tom Chimes S

Triangle

Tribal 1

Tribal 2

Tribal 3

Tribal 4

Tribal 5

Tubular Bell

Ultra Long BD

Vibragression S

Water Drum

Water Triangle

Wood Knock

Xplosion
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  MIDI Learn

Most UVI Workstation parameters can be automated via. a convenient 

MIDI Learn. MIDI Learn allows you to bind a physical MIDI controller 

to specific parameters within UVI Workstation.

  Any FX tab parameter, Macro Knob or Slider in UVI instruments can 

use the MIDI Learn feature

  The MIDI controller type and the MIDI Channel assignment will be 

saved with the multi or with your song in the host sequencer 

  Automation is assigned per-part

To use MIDI Learn:

1. Right-click the parameter in UVI Workstation that you want to 

automate

2. After the MIDI Learn dialog appears, Trigger the desired MIDI input 

controller (knob, fader etc.)

To remove a MIDI controller assignment: 

Right-click the desired parameter and press “Delete”

  Arpeggiator

UVI Workstation comes equipped with a robust arpeggiator. To insert 

an arpeggiator in a part, you need to display the Single view in the 

UVI Workstation, then click on the note icon. The arpeggiator can 

be employed as a pattern gate, arpeggiator, or even an advanced 

rhythmic processor for your live MIDI performance or sequenced MIDI 

tracks. Arpeggiators can be inserted in an unlimited number of parts.

  Preset Stacking

Thanks to the simplicity of the UVI Workstation you can stack as 

many preset as you want by simply assign multiple part on the same 

MIDI channel.

  Scroll Wheel

All knobs can be adjusted with the scroll wheel on your mouse. 

When you double-click on any knob or slider, you can manually enter 

or type in the desired value.

  Split, Velocity & Key Switch

The Keyswitch settings allow you to load multiple presets into two 

or more parts and dynamically play and mute them from your MIDI 

controller using key switching, note range, velocity range or any 

combination of the three parameters. This powerful feature gives you 

a great deal of real-time control.

  Unlimited FX

UVI Workstation offers a wide variety of FX, or effect processors, 

to cover all your audio processing needs. The FX implementation is 

robust and includes the ability to insert unlimited FX slots in several 

stages of the signal flow.

  Click the “FX” tab to open the FX page on the Single view 

  In Multi view the FX section is always displayed

UVI Workstation: Tips + Tricks
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Links

UVI

Home . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/ 

Download UVI Workstation and User Manuals . . . . . . . . . . . . . . . . . . uvi.net/downloads 

Your Registered Product Serial Numbers and Download Links.  .  .  .  .  .  .  .  .  uvi.net/my-products 

FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/faq 

Tutorial and Demo Videos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . youtube.com/

Support . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . uvi.net/contact-support 

iLok

Home . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/ 

iLok License Manager  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/ilm.html 

FAQ . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ilok.com/supportfaq 
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